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Introduction

Abstract

The following is documentation of the development of a Solidworks modeling technique based
off the Skeletal Sketch Part Method (SSP), with the goal of modeling movable bridges in a dynamic
environment. This method is based on the method described in John Stoltzfus’s documents, orig-
inally pioneered by Neil Sardinas from Prism Engineering. The purpose of pursuing this method
is to reduce the number of mates in the final assembly, and allow for changes on the fly that don’t
break the assembly. The SSP method in general, uses only sketches and planes to define key char-
acteristics of the parts that make up the assembly. This differs from the traditional bottom-up
design in that almost all mates are discarded and sketch relations are used in their place.

This manual is a thorough guide on how to produce robust Skeleton Sketch Part assemblies.






Chapter 1

Preliminary Work

1.1 Overview

Before any modeling can be done a significant amount of time must be devoted to defining the
project scope, flow, and organization. The first and most important step is to define the scope
of the project. What do you want to accomplish with the model? What features of your model
are subjected to change at any moment? What parts and sub-assemblies interact with each other?
What is the hierarchical dependency of each subassembly and each part that constitutes each
assembly? Answering these questions will put the model on the track to success before a single line
is drawn.
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1.2 Scope

In general the purposes of modeling a movable bridge are to check for appropriate space lim-
itations, correct operation, give a strong visual model for engineers and contractors, and to aid
in the development of engineering drawings. A few features that can change on a whim are the
footprint and elevation of the main pier, distance to the centerline of the channel, structural mem-
bers, machinery components and locations, wall thicknesses, and conduit/piping paths. Designing
sketches to be able to handle these changes without causing failures down the line is crucial to the
effectiveness of this method. The last two questions will be answered more in depth during the
organization and flow design, but as a broad example electrical components depend on mechanical
components, and both depend on the structural components.

1.3 Flow

After the scope is defined the organization and flow of the model can be determined. Every
part must first be identified, and sorted into different sub-assemblies. A considerable amount of
work and planning must be put into recognizing the relationships between different parts and sub-
assemblies. A hierarchy must be developed based off these relationships, and this will help drive
the whole design process. In general, the hierarchy begins with the master SSP, and then is broken
down into the main sub-assemblies.

For movable bridges the sub-assemblies are usually broken down based off of location. Typical
top-level sub-assemblies are Pier, Tower, and Span. Each of these sub-assemblies will have their own
SSPs, parts, and multiple sub-assemblies. Every sub-assembly, and even parts, will have its own
SSP derived from its parent sub-assembly. Each skeleton sketch part should only derive information
from the next level up. For instance, if we have Master SSP - Sub SSP - Subsub SSP, the Subsub
SSP should only be driven from Sub SSP, and not the Master SSP. The basic idea is to keep it
simple. Assemblies should not have too many parts and skeleton sketches should have only the
basic information needed to drive the parts associated with them.

While it may seem labor intensive to create these parts and assemblies, it puts the work up
front, and makes downstream changes easier to make without the need to fix what can be a very
complicated mess of mates in the feature tree. An example is given in Figure 1.1. The hierarchy
follows dominance from the top left to bottom right. Placement interactions are shown as arrows
between parts. Placement of parts in the same groups are contingent upon each other already.



Figure 1.1: Example Flow






Chapter 2

Setting Up Solidworks

2.1 Overview

To speed up the development of a project from the start of the modeling process to the pro-
duction of engineering drawings some upfront work is required. Most of this work will be creating
templates and file naming conventions that allow project information to flow into every part with-
out having to do too much manually. When done properly this can save a lot of time that otherwise
would’ve been spent editing properties in monotony. It also reduces the chances of clerical errors.
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2.2 Templates

Templates are a great way to propagate information to all parts, and reduce monotonous tasks.
They serve as the base when starting a new part, assembly, or drawing. To create a new template
start by pressing New Document, as shown in Figure 2.1.

(%SOL'DWORKS‘ File View Tools Help b g ‘ D s @ x = x v x {:@} 5

Figure 2.1: New Document Location

2.2.1 Part and Assembly Templates

Next select the ”Template” tab (the ” Advanced” options button must be pressed for this to
show up), then select which type of template you wish to make. Figure 2.2 shows a part template
being selected.

-
New SOLIDWORKS Document =5
| Templates | Tempiates | Bridge | H.002264 Barataria
MName Size Modified = .I
[B) part 47KB INI/0141... 3
-z Preview

Assembly 44KB 2/12/2014 1...

Drawing 55KB 2132/2014 1.
i Preview is not available.

e e

Figure 2.2: New Template Location

The screen appears the same as a standard new part, and anything done in this space can be
permanently saved as part of the template. Anything saved to the template will appear in any
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part that you create with the template. Now there are three main things that are usually done
with part and assembly templates. The first, and most obvious, is creating and renaming planes,
axis, and origins. Figure 2.3 shows an example of a part template. Only the standard planes were
renamed in the design tree (highlighted on the left side), and the planes were set to visible(which
can be accessed by clicking on the eye highlighted at the top middle). New planes, sketches, and
even surfaces or solid bodies could be added if it was universal to all parts.

ents | Mold Tools | Evaluate | Dimipert | SOLIDWORKS Add-Ins | 3D Splines | Blucbeam PERABE - B -»- @ -2

Figure 2.3: Example Part Template

The second feature of templates is the ability to add custom properties. These properties usually
contain part number, description, cost, or revision, but just about anything can be attached to the
file. To get to custom properties press the highlighted button shown in Figure 2.4.

DrE-as--MleBEs-

Figure 2.4: Custom Properties Button

Next, click on the ”Custom” tab shown in Figure 2.5. New properties can be added to the
”Property Name” column. These can be chosen from a pull down menu or added by hand. You
have the option to change the type and description.
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Summary Information

=B %
Custom | Configuration Specific
BOM quantity:
Delete - None - b Edit List
Property Mame Type Value / Text Expression Evaluated Value
Project Text » | H.0022564 Barataria H.002264 Barataria
PartMo Text -
<Type a new property> -
I QK l ’ Cancel l ’ Help
1.

Figure 2.5: Custom Properties Tab

The final feature of templates, and possibly the most important, is the ability to edit the

document options, and apply them to every part made with the template. This can be accessed by
clicking the button highlighted in Figure 2.6.

D-F-@-8-9-13-10 E&-

Figure 2.6: Options Button

Once in the manager, either the system options or document properties can be edited. Any
changes to the system options will affect the whole system regardless of template. Changes to
document properties only affect documents made with the template. One of the most important
system options that must be activated to properly use the SSP method is shown in Figure 2.7. If
this feature is not checked, it won’t be possible to derive sketches from an SSP to parts that are
in separate assemblies. One of the most important document properties is the unit system, which
can be accessed as shown in Figure 2.8. The system, precision, and rounding can be edited here.
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System Options - External References -

System Options | Document Properties €3 search Options Q

General [T] Open referenced documents with read-only access
Don't prompt to save read-only referenced documents (discard changes)

Drawings

Display Style Allow multiple contexts for parts when editing in assembly
Area Hatch/Fill Load referenced documents:
Performance
G Load documents in memary only
Sketch Search external references in:
! Relations/Snaps Referance Documents specified in File Location
Display Include sub-folders
Selection [T] Exdude active folders and recent save locations
Performance
;
Assemblies
External References §
T e Update out-of-date linked design tables to:
File Locations A semblics
FeatureManager [T Automatically generate names for referenced geometry
Spin Box Increments Update component names when documents are replaced
View [] Do not create references external to the model
Backup/Recover
Tt Show " in feature tree for broken extemal references
Hole Wizard/Toolbox
File Explorer
Search

Collaberation
Messages/Errors/Wamings
Import
Export

[ ok ][ Cancel ][ Help

Figure 2.7: Multiple External References System Option

Document Properties - Units | e i (ot
| System Options| Dacument Properties {} search Options Q
Drafting Standard Unit system
4. Annotations. () MKS (meter, kilogram, secand)
s CGS (centimeter, gram, second)
e e e
Tables A
DimXpert
Detailing
Grid/Snap Type Unit Decimals Fractions |Mor=
Basic Units
Model Display Length inches 123 ]
Material Properties Dual Dimension Length | millimeters 1z —
Image Quality
Mo Angle degrees 12
Weldments [Mass/Section Properties
Plane Display Length inches None
Configurations e ol
Per Unit Volume inches 3
[Motion Units
Time Second 12
Force pound-force 12
FPower Watt 1z
Energy ’ﬁu 12
Decimal rounding
Round half away from zero
Round half towards zero
) Round half to even
) Truneate without rounding
Only apply rounding methad to dimensions

L ok ][ Cancel ][ Help

Figure 2.8: Unit System
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It may be beneficial to also change the precision of dimensions. This can be done as shown in
Figure 2.9. There are many more options in this field and the document properties as a whole.
The user should go through and check out each tab to be sure everything is set up correctly before
moving on to save the template. In particular ”Image Quality” and "DimXpert” can be especially
beneficial to set up to make the program look better or run smoother, and save time on the back

end.

Document Properties - Dimensions

1
|
@

-

Drafting Standard

@ Annotations

-Virtual Sharps
[ Tables

m DimXpert
Detailing
Grid/Snap

Units

Model Display
Material Properties
Image Quality
Sheet Metal
Weldments
Plane Display
Configurations

System Options| Document Properties

{:@} Search Options

Owverall drafting standard
ANSI-MODIFIED

Text

Century Gothic

Dual dimensions

|:|Dua| dimensions display DShow units-Fopidusl

display
@ Top () Bottom ) Right @ Left
Primary precision Dual precision
viff (123 ] w12 -]

R . S .
L, [ Same as nominal v] L3, [ Same as nominal v]

Fractional display

Style:

Show double prime mark [7): |III!

Dlnclude leading zero for values less than 17

N Stack size: [100%: =

Bent leaders

Leader length: 0.25in Extend to text

Leading zeroes: | Standard .

|:| Show units of dimensions

DAdd parentheses by default

|:| Center between extension lines

|:|Ir|clude prefix inside basic tolerance box
|:|Display dual basic dimension in one box
Show dimensions as broken in break views

Arrows

0.13in

0.25in

[ scale with dimension height

Style: —J- ~ g‘@

Offset distances

- 0.236in

| r-n--]l-

r E

0.394in

Radial/Diameter l[eader snap angle:

Tolerance...

| Apply updated rules

15deg

[ o

) [ ] |

Help

Once the template is configured properly it must be saved correctly. It must be saved as a
template to the file location shown in figure 2.10. Use File>Save As and select ” Template”. This
will save the file with a .prtdot file extension (this is just for parts, assemblies will be .asmdot and

Figure 2.9: Smart Dimension Precision

drawings will be .drwdot). A new folder specific to the project can be created if needed.
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-

<18

dh i _
|5. » Computer » bridge (\WHO0001MS016) (R:) » GangS » Solidworks » Templates and Settings » Templates »

-

Figure 2.10: Template File Location

It may be necessary to configure the system options to show a new templates folder when
creating a new part. The location where this can be accomplished is shown in Figure 2.11. This
process works the same for assemblies, and it is recommended that the assembly template is the
same as the part template, although it is not necessary.

- = - - - = ™
System Options - File Locations - ﬂ

System Options | Document Properties {8} search Options Q
General shestdiosion
Drawings Document Templates - Edit All
- Display Style Folders:

: - Area Hatch/Fill R:\Gang5\Solidwarks\Templates and Settings\Templates Add...
i.. Performance C:\Program Files\SolidWaorks Corp'\SolidWorks\data\templates

Calars R:\Gang5\Solidworks\Templates and Settings\Templates\Bridge\H.00228

Sketch
. Relations/Snaps
Display

Maove Up
| Move Down |
Selection
Performance
Assemblies
External References
Default Templates
FeatureManager
Spin Box Increments
View
Backup/Recover
Touch
Hole Wizard/ Toolbox
File Explorer
Search

Collaboration

Messages/Errors/Warnings
Import
Export

[ ok || caneet | | Heo

Figure 2.11: Adding Template File Location in System Options
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2.2.2 Drawing Formats and Templates

Drawings are a little different from parts and assemblies, not only because they do not have
the same overall layout (2D instead of 3D etc.), but because they also have sheet formats that can
be edited. Drawing templates are the same as part templates, and follow all the same steps. The
only difference is that there may be more information added in the ” Custom Properties Tab” as
shown in Figure 2.12. The user may also want to change some of the document properties, but the
options are the same.

-
Summary Information E@g
BEOM guantity:

Delete - None ] - Edit List

Property Name Type Value f Text Expression Evaluated Value
1 |Project Number Text |z H.002264 H.002264
2 |Project Title Text =) BAYOLU BARATARIA BASCULE BRIDGE BAYOL BARATARIA BASCUL
3 |Parish Text |z JEFFERSON JEFFERSCON
4 |District Text hd
5 |Control Section Text |z 826-39 826-39
6 |Route Text |x|Las02 LA3D2
7 |Sheet Section Text L2 Fl
8 |SWFaormatSize Text [ 11072107 11072107
9 |Sheet Title Text |z FIRST SHEET TITLE FIRST SHEET TITLE
10 |<Type a new property= I

[ oK ][ Cancel H Help

Figure 2.12: Custom Properties Tab For a Drawing

One of the most crucial components of a drawing is the sheet format. The sheet format contains
all the general information about the project, such as the title block, borders, logos, and anchors
for various tables (BOM, Cutlists, etc.). It would be extremely tedious and improbable to create
a sheet format for each drawing, luckily formats can be created and linked to templates. The first
step is to open a new blank drawing in the same way as described in Section 2.2.1 (this can be an
actual drawing file or drawing template). Select the sheet size by clicking Edit>Properties (the
sheet must be selected). Figure 2.13 shows what the dialog box should look like.
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»
Sheet Properties [ ? g
Sheet Properties | Zone Parameters

17

Type of projection
Name: Em T Mext view label: A
() First angle
Scale: 1 2|4 @) Third angle MNext datum label: A
Sheet Farmat/Size
(@ Standard sheet size P

|:| Only show standard format

A [AMSI) Landscape - Reload
A [ANST) Portrait ]
B [AMSI} Landscape —
C [ANST) Landscape

D [AMSI) Landscape

E [ANST) Landscape

a0 TAMST landsrane

R:\Gang5\Solidworks\Temp

[¥] Display sheet format

-

(7) Custom sheet size

wdth:

Use custom property values from model shown in:

Default -

Select Sheets to Modify

Same as sheet specified in Document Properties

Update All Properties Apply Changes ’ Cancel l’ Help

Figure 2.13: Sheet Properties Dialog Box

After choosing and accepting a sheet size the format can be edited. Click Edit>Sheet Format,
and Solidworks will isolate the format. Now the title block, borders, and anchors can be customized.
When finished click Edit>Sheet to get back to the drawing. Once the format is satisfactory click
File>Save Sheet Format.... This will save the file with a .slddrt extension. Once again a file
location must be selected, and it is recommended to have a dedicated folder to sheet formats in an
easy to find location. Figure 2.14 shows an example location.

@\;}vl J ¥ Computer » bridge (\\HOO001MS016) (R:) » Gang5 » Solidworks ¢ Templates and Settings » Sheetformats »

Figure 2.14: Sheet Format File Location

It may be necessary to specify the location in the same way the templates were done. This can
be accessed under system options as shown in Figure 2.15.
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-
System Options - File Locations ﬁ

System Options | Document Properties {83 search Options Q

General Show folders for:
Drawings Sheet Formats - Edit All
- Display Style Folders:

- Area Hatch/Fill C:\PragramData\3olidWorks\SOLIDWORKS 2017\ang\english\sheetfarm| [ agq...
.. Performance R:\Gang5iSolidworks'Templates and Settings\Sheetformats

Sketch
.. Relations/Snaps

Move Up
Display Move Down
Selection
Performance
Assemblies

External References
Default Templates
File Locations
FeatureManager

Spin Box Increments
View
Backup/Recover
Touch

Hole Wizard/Toclbox
File Explorer

Search

Collaberation
Messages/Errors/Warnings
Import

Export

[ ok | [ cancat | [ hew |

5
e |

Figure 2.15: Adding Sheet Format File Location in System Options

The final step is to link the sheet format with the drawing template. Return to the sheet prop-
erties tab (Figure 2.13) and click the ”"Browse...” button under the ”Sheet Format/Size” heading
and select the desired format. Once finished editing all the properties save the file as a template in
the same way as in Section 2.2.1.

2.3 Numbering Parts

Before proceeding, a file naming convention should be established to make it easier to find
assemblies by discipline. We have 4 major disciplines that work on movable bridges, structural,
mechanical, electrical and architectural. Therefore, it is broken down by disciplines in Table 2.1.
This will also prevent parts with the same names from different projects from interfering, as well
as enabling the reuse of parts. This list will change for each different type of bridge, and even
different bridges of the same type that use different drive methods.
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Filename Prefix

Section

H.XXXXXX-00- Bridge Assembly
H.XXXXXX-S1- Piers and Piles
H.XXXXXX-S2- Towers
H.XXXXXX-S3- Movable Span
H.XXXXXX-S4- Approaches

H.XXXXXX-M1-

Turned Bolts

H.XXXXXX-M2-

Span Drive Machinery

H.XXXXXX-M3-

Rack and Pinion Assembly

H.XXXXXX-M4-

Trunnion Assembly

H.XXXXXX-M5-

Span Lock Assembly

H.XXXXXX-M6-

Buffer Assembly

H.XXXXXX-MT7-

Limit Switch Assembly

H.XXXXXX-MS8-

Movable Parking Barrier Assembly

H.XXXXXX-A1-

Operator’s House Assembly

H.XXXXXX-A2-

Operator’s House Structure

H.XXXXXX-A3-

Operator’s House Openings

H.XXXXXX-A4-

Operator’s House Storefront

H.XXXXXX-A5-

Operator’s House Guardrails

H.XXXXXX-A6-

Operator’s House Roofing System

H.XXXXXX-AT7-

Operator’s House Mechanical

H.XXXXXX-A8-

Operator’s House Electrical

H.XXXXXX-E1-

Electrical Assembly

H.XXXXXX-E2-

Electrical Boxes

H.XXXXXX-E3-

Electrical Conduit

Table 2.1: File Naming Convention For Barataria Bascule
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2.4 Organization

When modeling large assemblies using any method in Solidworks organization is key. The
number of parts can easily reach into the thousands. Using the SSP method the number of parts
won’t really change, but there will be a much larger number of sketches and planes in one single
SSP part. This means a user must be extremely organized from the beginning. The first steps are
to design a hierarchy as described in Section 1.3, and a robust part numbering system as descried
in Section 2.3. This section is dedicated to any other techniques that can be used to stay organized.

The most obvious way to organize a master assembly is to break it down into multiple sub-
assemblies. In a way a lot of the legwork is done when developing the hierarchy, but there may be
too many sub-assemblies to feasibly include them all in that hierarchy. It may be useful to compose
a hierarchy for individual sub-assemblies listed at the bottom of the master hierarchy. At a certain
point it may not be as practical to keep creating sub-assemblies, and folders should be used.

Creating a new folder in Solidwork’s design tree is very easy and useful. They can be used to
group anything together. For example a collection of sketches in SSP can be grouped together, or
a group of parts in an assembly, or even features in a part. This could save the time of having to
name all the features of a part, and instead just name the folder. To create a folder just right-click
the part or parts you want to go in the folder and click ”New Folder” as shown in Figure 2.16.
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Figure 2.16: Adding a New Folder
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Past organizing groups of entities into folders, it will become necessary to organize the infor-
mation inside the folders. This can easily be accomplished by renaming the sketches. The names
should relay the information about what the sketch is controlling and its purpose. This concept
should also be applied to the dimensions, especially those that control information that propagates
to other sketches, and those that may be subject to occasional changes. Another effective orga-
nizational tool at this level is to change sketch colors. This is a great visual tool when there are
multiple sketches in one compact area. To change the color of a sketch right click the sketch in the
design tree, and there should be a ”Sketch Color” option. Note that this might not be available
while the sketch is being edited, and must be done while editing the part that contains the sketch.
It may not be possible to change the colors while editing the part in an assembly either. This is
shown in Figure 2.17.
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Figure 2.17: Changing Sketch Color

Some sketch colors should be avoided though. Blue is a poor choice because Solidworks uses
blue by default to show under defined sketches. Dark or light blue should be fine, but in general it’s
best to stay away from any hue close to that recognizable Solidworks sketch blue. Gray and black
should also be avoided as these colors represent a sketch being edited by default. These default
colors can be changed in the system options referred to in Section 2.2.1.

Following these guidelines should make the drawing and assembling processes much easier and
quicker.






Chapter 3

Modeling

3.1 Overview

Now that all the legwork is done, the actual drawing can begin! This chapter will walk through
the process to develop a large assembly using an SSP. A precise process has been developed by the
original pioneers of this method. This has cut down on most problems with SSP method, and has
created very robust models. This process and the SSP itself will need to be discussed in detail,
along with the concept of zones and their benefits. Finally all this upfront work will begin to pay
off as the procedure for inserting parts is discussed. Just like with the rest of this method there is
a finely honed series of steps that must be learned, but once it becomes second nature this method
will become faster and more robust than bottom-up modeling methods.
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3.2 The SSP

It has probably become pretty obvious that the Skeleton Sketch Part is the heart of this whole
modeling technique. The main SSP will be at the top of the design tree for the main assembly with
the next level sub-assembly SSPs within. It will drive at least one dimension in every subsequent
sketch. Figure 3.1 shows where the highlighted SSP is located in the design tree of the main
assembly.
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ia - Drive Machin (Default: play

(Default<Displa

Figure 3.1: Design Tree

In the end there will be multiple SSPs at many different levels. Each SSP should only propagate
information to the sub-assemblies’ SSPs directly below it. This was briefly discussed in Section 1.3,
and is an important concept to keep the sketches simple and flexible. When trying to plan what
should go into an SSP the designer must figure out what information will need to be propagated
to the next level. The key here is to keep the SSPs minimal with sketches and dimensions labeled
and organized. It is also worth noting that no part should be referencing another non-SSP part if
possible. Also an SSP is not necessary if there is only one part referencing it. Figure 3.2 shows
an expanded design tree. Notice the numbers at the beginning of each part and assembly. The
numbers help keep track of where each part belongs. There should never be a lower number part
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inside a higher number assembly except for the main SSP for that assembly (e.g. Movable Span
SSP in the Movable Span Assembly).
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Figure 3.2: Expanded Design Tree
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For a bascule bridge, the main SSP will be directly above the Pier, Tower, Movable Span, Drive
Machinery, Trunnion Machinery, and Approaches SSPs. The most minimal amount of information
that could be put in the main SSP would be just the center distance from the centerline of the
channel to the centerline of the pier. There is almost no limit to the maximum amount of informa-
tion you could put in, but to allow for effective control and simplicity at the top level a compromise
must be made. This may lead to including the tower footprint, the tower height, floor/cross section
change heights, and main girder separation. The end result is a very simple sketch with a high
level of influence on the model.

When starting a new project it’s always a good idea to create the top level sub-assemblies and
SSP and combine them in the master assembly. Start by creating the master assembly, and then
inserting a ”New” part and save it as the SSP. Figure out how many sub-assemblies will be directly
below the main assembly, and create these sub-assemblies with the SSP inserted using an origin
coincident mate. Finally insert the sub-assemblies into the master assembly using the same origin
coincident mate. Now the SSP can be opened and the sketches will propagate to all assemblies.

3.3 Zones

In large assemblies it may be very beneficial to create separate zones to work in. These zones
can define a certain region of the design, such as different floors, or they can be equally partitioned
from the main assembly into quadrants or grids. These zones can each have their own SSP, but each
assembly must still contain all SSPs from each zone. Using zones can keep the sketches organized
and allow work to be done in different regions at the same time. To reduce dependency of zones,
they should only be connected to adjacent zones by their boundaries.

3.4 Inserting a Part and Deriving Sketches

Once the SSP has been developed significantly, the parts will need to start being created. It
is important to follow the method laid out in this section for inserting new parts. It will insure
that the proper relations are preserved, and the part is inserted how the user would expect. To
begin open the sub-assembly that the part will be located in (for example the tower would be in
the structural sub-assembly). Click Insert>New Part and save the part file (there is an option
in the settings to make Solidworks prompt the user to save new parts when they’re inserted into
assemblies). Solidworks will then wait for the user to select a plane to begin sketching the new part,
always choose the same plane of the assembly/sub-assembly for every part/SSP. I always choose
the Middle Plane (or Front Plane) for my models. Then immediately close that sketch. Doing this
keeps all the parts/SSPs origins, axes, and planes aligned with the main assembly. Now right click
on the SSP in the design tree, and click ”Isolate” as shown in Figure 3.3.
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Figure 3.3: Isolating the SSP

Now select the plane the part will be made from, and holding the ” Ctrl” key select the proper
sketch from the SSP that will be used to make the part. Click Insert>Derived Sketch (shown in
Figure 3.4) and a copy of the original sketch will be created on the selected plane. Any changes to
the original sketch will be applied to the derived sketch. It is possible to use the ” Convert Entities”
command, but it doesn’t create as strong of a relationship as the ”Derive Sketch” command.
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Figure 3.4: Deriving a Sketch

Once the sketch in the new part has been completed use various features to create the solid
bodies of the part. The features should use parts of the sketch to define itself. For example, instead
of extruding a set distance, there should be a vertex or plane at the beginning and end of the desired
extrusion path. Use the from vertex/plane up to vertex/plane commands as shown in Figure 3.5.
Using the sketches as controls for the features will allow the parts to change any time the SSP is
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modified. This means that almost all changes can be done from the SSP and will propagate to all
other assemblies and parts.
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Figure 3.5: Extruding a Part

It is worth noting that when taking advantage of symmetry, use the ”Mirror Features” command
instead of ”Mirror Sketch” command. Mirrored sketches aren’t as robust as mirrored features. A
mirrored sketch won’t show up in the design tree, and it’ll be harder to tell what entities were
mirrored if the need to edit the sketch arises. Doing this will also reduce the overall amount of
sketches that’ll clutter the model.
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3.5 Tips, Best Practices, and Warnings

To be developed...



Chapter 4

Barataria Walk-Through

4.1 Overview

In order to properly explain and document the SSP process, the design of the Bayou Barataria
Double Leaf Bascule Bridge will be explained step by step. The process will be documented in
the same way this document is laid out, starting with scope and flow and ending with the creation
of the whole assembly. Much of this work has already been shown as examples in the preceding
sections, but everything will be reiterated in this chapter.
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4.2 Scope and Flow

The Barataria Bridge will be a double leaf, semi-high level, bascule bridge. The majority of
the structural components haven’t been designed at the writing of this document. Thus the model
will have to have a large amount of flexibility. Luckily the bridge is being based off the previously
designed Louisa Double Leaf Bascule Bridge, so we have a solid starting point. For the most part
the bridge will be symmetrical about the centerlines of the channel and the tower, so we can get
away with modeling a quarter section of the bridge.

The hierarchy will be the same as the example given in Section 1.3 (shown below in Figure
4.1). The structural components are at the beginning of the hierarchy (shown in orange) starting
with the Pier Assembly. Below the pier are the rest of the structural components, and then the
mechanical and electrical parts after. The different engineering domains are shown in different
colors. The first parts to be made will be the piers then towers and all the components affiliated
with them.

Figure 4.1: Barataria Hierarchy
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4.3 Templates and Organization

Part, assembly, and drawing templates have been developed for Barataria. In the part and
assembly templates the project information has been added, and the original planes were renamed
as shown in Figure 4.2. This is really all that has been done to the templates, as there are not
many other components that will be universal to the whole assembly.

ools | Evaluate | DimXpert | SOLIDWORKS Add-Ins | 3D Splines | Bluebeam LELARE - B-v- -0

Figure 4.2: Barataria Part/Assembly Template

The drawing template contains the project information, as well as the standard title block we
use. The information that will be universal to all drawings in the title block has also been filled
out. The important info is shown in Figure 4.3. Note that this is only a part of the title block and
doesn’t include the revisions section.
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DETAILED
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Figure 4.3: Barataria Drawing Template
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The same naming convention from Section 2.3 will be used for this project. Table 4.1 shows the
names of the parts. Special attention should be given to the structural and mechanical components.
Notice the different prefix numbers. The higher numbers are nested in the lower numbered assembly
above them.

Filename Prefix

File Name

0 - H.002264 Barataria -

Main Assembly

1 - H.002264 Barataria -

Pier Assembly

1 - H.002264 Barataria -

Tower Assembly

2 - H.002264 Barataria -

Movable Parking Barrier Assembly

1 - H.002264 Barataria -

Movable Span Assembly

2 - H.002264 Barataria -

Center Lock Assembly

2 - H.002264 Barataria -

Movable Span Tail Lock Assembly

1 - H.002264 Barataria -

Approaches Assembly

2 - H.002264 Barataria -

Approach Tail Lock Assembly

1 - H.002264 Barataria -

Drive Machinery Assembly

2 - H.002264 Barataria -

Drive Machinery Electrical Assembly

1 - H.002264 Barataria -

Trunnion Machinery Assembly

2 - H.002264 Barataria -

Span Limit Switch Assembly

1 - H.002264 Barataria -

Operator’s House Assembly

Table 4.1: File Naming Convention For Barataria Bascule

4.4 Modeling

4.4.1 Master SSP

because we will take advantage of symmetry later.

After creating the SSP, the main assembly, the first level sub-assemblies, and following the
process laid out in Section 3.2, we can begin to draw. The first sketch will be on the ”Zero
Elevation Plane” and it will consist of the overall footprint of the tower, the distance from the
center line of the channel, and the distance between main girders. The sketch is shown in Figure
4.4. There will be another tower opposite the channel centerline, but it is unnecessary to draw
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Figure 4.4: Tower Plan View
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The next step will be to draw the elevation view for the tower on the ”Center Plane”. This
will consist of a simple line extending above and below the ”Zero Elevation Plane”. Along the line
are multiple key points that represent a different elevation or thickness of different parts of the
tower. Shown in Figure 4.5, the elevation dimensions can be seen on the left hand side. These are
taken from the ”Zero Elevation Plane”. On the right side of the image are the thickness dimensions
taken between two points along the line. This may seem simple, but the sketch contains a lot of
information.

739.000

(Roadway Elevation)

565.000
{Machinery Floor Elevation)

250.000

{Lower Floor Elevation)

660.000
(Trunnion Elevation)

62.400
(Footing Elevation)

84.000
{Seal Thickness)
84.000
(Footing Thickness)
12.000
{Lower Floor Thickness)

12.000

(Roadway Thickness)

12.000

(Machinery Floor Thickness)

Figure 4.5: Tower Elevation View

This concludes all the information that will be included in the master SSP. Now we save every-
thing and all of the sub-assemblies should include this information.
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4.4.2 Structural Components

For the structural assembly we will have 4 main SSPs, the tower, the pier, the movable span,
and the approaches. First we will go into the structural sub-assembly and insert the master SSP as
described in Section 3.2. We will go ahead and add the 3 sub-assemblies and the 1 part according
to Section 3.4. Don’t forget that the main SSP should be in the structural assembly at the top of
the design tree. The pier is the easiest to do, so we will start with this and leave the others blank
for now.

Pier

To start we open the pier assembly that was created in the last step. We need to create a pier
SSP part inside the pier assembly first. Now we must repeat the same process as before, and insert
all the components that will be found in this assembly. This includes the footing, fenders, and the
piles. For the next step it may be necessary to open the structural assembly. We select the ”Zero
Elevation Plane” and the Tower Plan View sketch to make a derived sketch. Now that the derived
sketch is inside the part’s design tree we can exit sketch and start a new one on the same plane.
We then draw the footing and seal with reference to the derived sketch. This is shown in Figure
4.6, notice that it is only a sketch of half the footing because we plan to use symmetry later.

| 117.000
l § § 33.000

Figure 4.6: Seal and Footing Sketch

Now we will use this sketch and the Tower Elevation sketch to extrude the footing and seal. We
select the entire enclosed region for the seal and extrude from the bottom vertex (seal elevation)
to the next vertex (seal thickness). A similar action will be taken to create the footing. Both of
these features can be seen in Figures 4.7 and 4.8. These two features will then be mirrored across
the ”Center Plane” to complete the footing. The final result is shown in Figure 4.9.
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Figure 4.7: Seal Extrusion

Figure 4.8: Footing Extrusion
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Figure 4.9: Seal and Footing Part



40

Chapter 4. Barataria Walk-Through

A similar approach will be taken for the pier protection (also called a fender). The plan view
will be sketched out and be based off of the derived sketch from the master SSP. The sketch will
be done in the pier SSP then a derived sketch will be created from the pier SSP to the fender part.
Then the sketch is extruded and mirrored just as before. The results are shown in Figure 4.10 to

Figure 4.12.
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Figure 4.11: Fender Extrusion
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Figure 4.12: Fender Part
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Tower

Now we will move on to the tower, which is a bit more complicated. The first step will be to
create the tower SSP. I'll insert this part and the other parts (Concrete, steel, and walkways) into
the structural assembly, and then start working on the SSP.

Next multiple planes were created to facilitate drawing in the future. A plane was created for
each elevation shown in Figure 4.5, except the trunnion elevation. A plane was also created for
each main girder. This can be seen in Figure 4.13. These planes will help later when drawing the
tower cross sections and the main girders. Each plane is attached to one of the key points in the
sketches. Thus if the sketch is edited the changes will propagate to the planes.

Figure 4.13: Tower SSP Planes and Derived Sketch

The plan for constructing the tower concrete will be to draw the various cross sections on the
planes we created earlier. These cross sections will then be extruded along the elevation sketch. It
may be necessary to create a separate top to the tower if it’s not uniformly flat. To start a derived
sketch was created from the sketch in Figure 4.4 onto the zero elevation plane in the tower SSP.
Then a new sketch was created on the Lower Floor Plane and the convert entities command was
used to pull in the outer tower wall boundaries from the derived sketch to our current sketch. The
wall dimensions were then put in for half of the tower (we can mirror the features later). The final
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sketch is shown in Figure 4.14.

12.000

Figure 4.14: Lower Floor Cross Section

Going back to the structural assembly, we edit the tower concrete part and insert a derived
sketch of the cross section onto the Zero Elevation Plane. Now we can take the new sketch and
extrude the cross section using the elevations as we did before. The final result before mirroring is
shown in Figure 4.15.

Figure 4.15: Lower Floor Cross Section Extruded

The same process will be repeated for each cross section of the tower. In this case we have
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two cross sections total. The sketch, resultant extrusion, and product after mirroring are shown in
Figures 4.16 to 4.18. Depending which contours are selected we can make a hollow section or floor,
or many other configurations.

Figure 4.16: Machinery Floor Cross Section

Figure 4.17: Machinery Floor Cross Section Extruded
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Figure 4.18: Tower After Cross Sections Are Mirrored
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Some extra details will need to be added to the tower, as well as the roadway layout on the top
of the tower. When there are small details like chamfers and local extrusions, it’s usually best to
add them after the overall model has been created. In the tower we added a few cuts, chamfers,
and a couple small extrusions, such as the ones seen below the machinery floor. The final result is
shown in Figure 4.19, it is also worth noting that I changed the floor plan of the machinery floor
as well as the material. This change occurred fairly smoothly, and I only had to edit the selected
contours in the extrusion feature. This image also shows the completed Pier Assembly with the
Footing, Seal, Pier Protection Cell, and all the associated piles. The concrete portion of the tower
is finally completed, but we still have to work on the steel supports inside, and the walkways and
stairs.

Figure 4.19: Final Tower Concrete
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Now I will do a model a preliminary version of the steel supports within the tower assembly. At
this time the steel supports are less developed than the concrete tower was, but even with a very
broad idea of how the steel will look we can create a robust and versatile model. Special care will
be taken to make sure that the majority of dimensions can be easily changed. Then once the final
dimensions are determined, we can modify the SSP with minimal effort. I've started this process

by creating a plane that is parallel with the middle plane, but located in the center of the tower as
shown in Figure 4.20.

——

Figure 4.20: Tower Middle Plane

The main steel members’ profiles have been drawn on either a plane or a surface of a part that
is above the steel in the design tree. There are three main sketches that will drive most of the
structural steel. The first is the member the actual trunnion bearing will sit on. The second is the
member that will hold up the previous one. The final main member will be embedded in a concrete

beam that will hold the first two members up. Figures 4.21 to 4.23 show the three sketches in
order.
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Figure 4.21: First Steel Member Sketch

Figure 4.22: Second Steel Member Sketch

Figure 4.23: Third Steel Member Sketch
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Now I will create the appropriate planes in the tower steel part and then derive these sketches
onto it. I will then extrude them and show an image of the final extrusion. The parts were extruded
to different vertices on the derived sketch of the machinery floor. The part before extruding is shown
in Figure 4.24. The final extrusion is shown in Figure 4.25.
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Figure 4.24: Steel Part Before Extrusions

B

Figure 4.25: Steel Part After Extrusions

Details such as stiffeners, weldments, and other small beams will be added in the future. These
details need not be sketched in an SSP, and will end up being drawn on the steel members shown.
This will prevent clutter in the SSP and allow more flexibility. For now we are done with the tower.
Without having the actual structure designed there is not much else we can do. I will also wait to
put in the walkways until the machinery is completed

As the design progressed and major decisions were made the steel changed fairly dramatically.
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We went to a single trunnion bearing on each main girder, so we didn’t need the two major support
columns on each side. Figure 4.26 shows the final steel design. FExecuting these changes proved to
be very simple with the SSP technique. I just deleted the horizontal extrusion, and deselected one
profile on two extrusions.

Figure 4.26: Steel Part After Changes
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Movable Span

We will now move on to the movable span. This assembly will probably be the hardest to create
for multiple reasons. The first and most obvious reason is that the structure has to be able to move.
The only effective way to accomplish this would be to insert the part differently from the process
described in Section 3.4. A few mates will be necessary to allow movement and positioning. The
second reason is that there is a large amount of steel connections and details. If we want to get
very in-depth with this assembly we will have multiple bolts and plates at every connection. The
shapes can also get complicated, and there isn’t much symmetry besides the center plane. To make
matters worse there are not many repeated connections. These problems would still be present
using other modeling techniques, but they are a bit more exasperated using the SSP method.

Before going any further we will need to figure out the Movable Span Assembly Design Tree up
front. Figure 4.27 shows the breakdown of the top level of the design tree. Notice the three SSPs,
one for the main span, one for the center locks, and one for the tail locks. These are separated
to keep SSPs simple, and drive the design down from the main movable span SSP. They are also
different areas of design, so it helps to keep each subassembly organized. Also notice the mechanical
parts are separate from the structural parts. This is because our section is responsible for only
the mechanical parts so our final drawings will exclude all structural components from the bill of
materials.

1 - H.002264 Barataria - Movable Span Assembly (Guide Span<Display State-1>)

FE History
[
Sensors

ign Binder

Center Plane

Origin

Barataria - ble Span Tail Lock 3y (Default<Display State-1=)

Barataria - Rack Gear<l> -» (Default efault>_Display State 1)

VirrerComponentl

Figure 4.27: Movable Span Design Tree
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For now we will leave out the connection details, mostly because they haven’t been designed
yet, and it would be a huge waste of time. The main girder is the most important part of this
assembly, because almost every interaction this assembly has with other assemblies goes through
the main girder. To start we need to create the movable span SSP. Then I derived a sketch from
the center plane and main SSP elevation sketch. Another derived sketch was created from the main
SSP plan view and the zero elevation plane. Then we need to create a new plane parallel to the
center plane, but located on one of the main girder centerlines of the main SSP plan view sketch.
Figure 4.28 shows the result of these steps. After the main girder we will model the movable span
from the highest elevation down. This is how our structural engineers design the bridge, so it only

makes sense to follow this method.

Figure 4.28: Beginning of Movable Span SSP
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After drawing the outline of the girder shown in Figure 4.29 we need to insert a part for the
main girder into the movable span assembly. We will create the same main girder plane, and derive

the sketch onto it as usual.

‘Cenfer Plane

Figure 4.29: Main Girder Outline

Now we will extrude the girder’s flange, web, and stiffeners. These features are some of the
only ones to use a blind extrusion distance rather than using vertices or planes. In order to keep
track of the different extrusions I named each feature. The final extrusion is shown in Figure 4.30
with the feature tree included, so you can see the different feature names. This pretty much sums
up the main girder, and now we will start building the rest of the span from the top down.

s[ElE[e]®] >
7
@ H.002264-53-Main Girder (Default<<Defar
[ ) History
) sensors
» 5] Design Binder
+ B) Annotations
[#) surface Bodies
» [&) Solid Bodies(1)
= e
[l Middie Plane
[l Zero Elevation Plane

> @) 115" Stiffeners

Figure 4.30: Main Girder Extruded
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Next we will do the roadway. This is going to be a grid deck, but to save time and processing
power, we will model it as a slab and set the material to a custom material with the same properties
as a grid deck, and a texture that resembles a grid deck. The base sketch is shown in Figure 4.31,
and it is extruded using a vertex extrusion set to the deck thickness. The final result is shown
in Figure 4.32. Notice the highlighted sketch of the W member below the deck. We want to use
weldments to create the stringers, but if we do, we have no way to locate the bottom of them
without referencing the solid bodies. This would create a circular reference with the SSP and the
Movable Span part. To get around this we draw a sketch of the stringer profile, but this does mean
we need to go modify dimensions anytime the member changes.

Figure 4.31: Grid Deck Figure 4.32: Deck

Next the stringers will be laid out using lines sketched on the ”Roadway Plane” in the movable
span SSP. I created a new plane in the Movable Span part on the bottom of the roadway deck.
This plane represents the top of the stringers. I then derived the stringers sketch onto this new
plane. Now I can add the appropriate weldments (W18x50) and locate the profile to the top of
the ”I”. The stringers sketch in the movable span SSP is shown in Figure 4.33. I've also chosen to
show the profile location process for the weldment in Figures 4.34 and 4.35.
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Figure 4.35:
Through Profile

Desired Location of Line

Now that the stringers have been created (there was some bracing added as well, but we wont
cover that), we can start working on the next level, the floor beams. The floor beams are the most
complicated and time consuming part of the movable span. I chose to just start each floor beam by
sketching on the corresponding stiffener, and converting entities as shown in Figure 4.36. 1 felt it
would be too complicated and not very beneficial to try and include the floor beams in the SSP, so
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all the information is included in the Movable Span part (other than the locations longitudinally
along the main girder, which is determined by stiffener location).

() Convert Entities
v X M

Select thain
Tnner loops one by one

Select all inner laops

Figure 4.36: Stiffener Lines to be Converted

Floor beams A to C are full depth, and floor beams A and B are identical. I started by fully
modeling half of the floor beam as shown in Figure 4.37.

Figure 4.37: Floor Beam A Half Section

I then mirrored the floor beam and main girder across the Center Plane, and used a linear
pattern to create floor beam B. I also went ahead and used another linear pattern to propagate
the supports on the outside of the girder to every floor beam since they use the same detail. The
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result is shown in Figure 4.38.

Figure 4.38: Floor Beam A and B

Floor beam C was modeled in the same fashion. The only difference between each full depth
floor beam (and each braced floor beam as well) is its height. I haven’t been able to find a way to
easily propagate floor beams without individually modeling each one (aside from patterning any
identical components). The typical braced floor beam is shown in Figure 4.39.

Figure 4.39: Typical Braced Floor Beam

The top and bottom members are both W Beam Weldments that are the same for each floor
beam of this type. This means we can pattern these features to make the remaining floor beams a
little easier to model. The bottom weldment follows a slope, so I had to select the inclined edge of
the girder as my guiding line (and do a little math to get the spacing correct). I did find a more
robust and flexible way of accomplishing this using a sketch driven pattern, but I will cover that
in the Approaches Assembly.
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Figure 4.40 shows the sketch used to model the bracing. The gusset plates are extruded, and
the T Beams are weldments. The half-bracing is then mirrored and the floor beam is complete.
This is continued for each of the remaining floor beams.

Figure 4.40: Typical Bracing Sketch

There are also upper and lower lateral bracing between the floor beams. This is done in a similar
way to the floor beams. Figure 4.41 shows the sketch for the upper laterals (the bracing is already
modeled in the figure). Once the extrusions and weldments were completed they were mirrored,
and because floor beam spacing was the same between all floor beams, we can use a linear pattern
to finish.

Figure 4.41: Typical Lateral Bracing Sketch

The lower laterals were done the same way, except they were on an incline, so a 3D sketch was
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used. This was a little more time intensive, but still fairly effective. This wraps up the bulk of the
work. Some extra details and smaller floor beams were added on the backside, and the final model
is shown in Figure 4.42.

Figure 4.42: Finalized Movable Span Part

The Movable Span part is complete, but the Movable Span assembly isn’t. The assembly not
only contains the structural span, but also any machinery located on the span. Figure 4.43 shows
the final SSP for the movable span. Movable Span Structural sketches are teal, Main Assembly
sketches are black, and Movable Span Machinery sketches are orange. The machinery sketches drive
the models of any machinery on the span. We will get into this more in the machinery section.

Figure 4.43: Finalized Movable Span SSP
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Approaches

The Approaches are the same type of span as the movable span (Steel Girder), so we will spend
less time diving into exactly how the model was created. I will describe, in detail, the features that
make it different, and any lessons I learned. Figure 4.44 shows the Approaches SSP. It has a lot
of the same features as the Tower SSP and Movable Span SSP. The approach specific sketches are
shown in light blue. Notice the pier sketches on the left, the main girder, and the roadway sketch.

Figure 4.44: Finalized Approaches SSP

The pier, footing, and piles were made in the same way as the tower concrete. The main
girder was made in the same way as the movable span. One of the more notable differences is
the the roadway starts off sloped on the pier side and transitions to flat at the other end. This
was accomplished by using a loft extrusion between the sloped sketch and flat sketch. The final
approach model is shown in Figure 4.45.

Figure 4.45: Finalized Approaches
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As stated previously in the Movable Span section, modeling the floor beams is very time con-
suming. Normally I would pattern any of the repeating aspects, but I would usually have to rely on
distances that wouldn’t automatically update if the model changed. I discovered the sketch driven
pattern and I believe this is a perfect fix. Now I can create a sketch that converts vertices of an
existing sketch (like the main girder sketch) at the locations of the floor beams. These sketches are
shown in Figure 4.46. This directly ties the pattern features to the SSP and allows the floor beams
to move with any changes to the SSP. The sketch in the red section locates the bottom W beam of
the braced floor beams, and the vertices in the blue section locate the flat part floor beams.

Figure 4.46: Sketch Driven Patterns

This sums up the modeling of the major structural components of the Bayou Barataria Bascule
Bridge. Next we will analyze the mechanical components.
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4.4.3 Mechanical Components

Most of the mechanical components will be modeled in the same way as the structural com-
ponents, but a few are purchased components that come with their own models. Now these parts
could be remodeled, but that is a lot of extra work that doesn’t need to be done. We want to use
these premade models, so we need to figure out a way to simply and stably incorporate them into
the assembly.

Before adding the bought components to the assembly we want each one to be a single part.
A lot of these premade components come in large assemblies that need to be converted to a single
part. This is a relatively simple procedure, but it is sort of hidden within Solidworks. Figure 4.47
shows a typical motor brake model we got straight from the manufacturer. As you can see there are
many sub-assemblies within the main motor brake assembly. These sub-assemblies each contain
many parts and even other sub-assemblies. You may also notice that all the part names are in
German, as this is from a German company.

or Brake (Default<Display State-1)

Figure 4.47: Typical Motor Brake Manufacturer's Model

Leaving this part as it is would take up a lot of computing resources, and complicate the bill
of materials. The first step is to add a part in the top level of the assembly using the Insert
Component > New Part command. Name the part according to your naming convention, then
select a plane and exit the sketch. The only place I have been able to find the Join command is
by searching in the command search bar. Once the Join command is executed select all of the
parts/bodies you want to create as one new part as shown in Figure 4.48.



4.4. Modeling 63

s mm.smws.m{u*sm;-mm B

leAIlpn;]@HIwZZEA M2 Motor Blak!/Ba(kt u_Belag-+-250,00067 -

i@l
leAIlpn;]@HIwZZEA M2 Motor Blak!/Ba(kt u_Belag-+-250.00067

i@l
leAIlpn;]@HIwZZEA M2 Motor Blak!/Ba(kt u_Belag-+-250.00067

leAIlpn;]@HIwZZEA M2 Motor Blak!/Ba(kt u_Belag-+-250,00067 -

leAIlpn;]@HIwZZEA M2 Motor Blak!/Ba(kt u_Belag-+-250,00067 -

leAIlpn;]@HIwZZEA M2 Motor Blak!/Ba(kt W Belag.- 25000067 1 @Motor BmkECA

Figure 4.48: Join Command Execution

Click the check mark and now the assembly contains all of the original parts and the new joined
part. I only work with the joined part for the rest of the process. In order to incorporate these
premade models in our bridge model we will have to use a mate. I have found the most effective
method to mate the model to the sketch is to put coordinate systems on the sketch and on the
model and use a coincident mate between them. This will be covered in the next section.

Drive Machinery

The Drive Machinery Assembly really starts with the movable span, which is why it must be
down stream from the Movable Span Assembly (and SSP). Figure 4.49 shows the Movable Span
SSP, and specifically the Rack Sketch in orange. The drive machinery is located by the angle
and center distance between the rack and pinion. This sketch and the two Main SSP sketches are
derived into the Drive Machinery SSP.

Figure 4.49: Rack Sketch
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From here we start the pinion sketch. The Rack Sketch and the Pinion Sketch were connected
using a tangent mate between the two pitch circles, and a center line with an angle defined between
it and a vertical line. Figure 4.50 shows the final Pinion Sketch.

Figure 4.50: Pinion Sketch

A plane was then created parallel to the Zero Elevation Plane at the center of the pinion.
Then the Machinery Floor Sketch from the Tower SSP was derived on this plane to give us
our boundaries. Then straight lines were drawn coming out of the pinion to represent different
shaft /bearing/coupling lengths and center lines. Finally I drew circles to represent the different
shaft diameters on the Center Plane, centered on the shaft center lines. These circles would be
extruded along the lines using a vertex to vertex extrusion.

I later found a more efficient method to create shafts that was easier to visualize as well. This
involves a revolved sketch rather than extruded, and it will be covered in the Trunnion Machinery
section. The last step in creating the Drive Machinery SSP is to add coordinate systems to the
sketches to attach bought components to. Figure 4.51 shows the final Drive Machinery SSP. Another
useful tip I've learned is to name the coordinate systems and use the principal axes to define it if
possible.

Figure 4.51: Final Machinery SSP
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Now we will go back to the Motor Brake to insert the coordinate system that will mate with
the coordinate system on the SSP. A plane was created in the center of the part, and then I made
a sketch by converting the drum outer diameter to create a circle. The coordinate system was
attached to the center of this circle. Figure 4.52 shows the final location of the coordinate system.

aria - Motor Brake (Default<<[

Figure 4.52: Coordinate System Location

The same technique was used to mate the bearings, machinery brake, couplings, motor, and
gear box to the SSP. Figure 4.53 shows the final layout of the drive machinery.

Figure 4.53: Final Drive Machinery

Trunnion Machinery

The Trunnion Machinery is a pretty small assembly, that contains the trunnion, trunnion bearings,
the trunnion hub, and some limit switches and brackets. It is located in a different area from all the
other machinery, so it was given its own assembly. The SSP is still a top level SSP, so its located in
the Main Assembly below the Main SSP, Tower SSP, and Movable Span SSP. The derived sketches
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include the two in the Main SSP, the main girder sketch from the Movable Span SSP, and finally
the trunnion steel sketch from the Tower SSP.

These sketches were chosen to get the proper locations of the trunnion and the base of the
trunnion bearings. Two planes were created at the trunnion center line, one parallel to the Center
Plane, and one parallel to the Zero Elevation Plane. Other than the two planes and four derived
sketch, the Trunnion Machinery SSP only has two other sketches. The Trunnion Revolve Sketch,
and the Trunnion Bearing Sketch.

The Trunnion Revolve Sketch contains a half section of the trunnion, trunnion bearing insert,
and the trunnion hub. The half section is then revolved around the center line to create all of the
before mentioned parts. I found this method to be superior to the vertex to vertex extruded sketch
method that was used on the drive machinery shafts. This is because the shaft can be visualized
in the sketch, resulting in quicker modification of the parts when needed. Figure 4.54 shows the
final Trunnion Revolve Sketch.

Figure 4.54: Final Trunnion Revolve Sketch

The Trunnion Bearing Sketch is more of a compliment to the Trunnion Revolve Sketch, with
the major diameters tied to the first sketch. The rest of the sketch just contains the body of the
trunnion bearing. Figure 4.55 Shows this sketch.

Figure 4.55: Final Trunnion Bearing Sketch
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All the components were created in the Trunnion Machinery Assembly and mirrored to take
advantage of symmetry. A limit switch and limit switch bracket were created as well, but they were
not complex enough to include in the SSP, nor did they affect other parts. Figure 4.56 shows the
final Trunnion Machinery Assembly before it was mirrored.

Figure 4.56: Final Trunnion Machinery
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